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Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons    to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You can
join forums to connect with other customers, post questions, and watch events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. (if videos) Videos
included in this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i

https://support.oracle.com/portal/
https://www.oracle.com/corporate/accessibility/learning-support.html#support-tab
https://www.oracle.com/education/
https://cloudcustomerconnect.oracle.com/pages/home
https://www.oracle.com/corporate/accessibility/
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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1  Get Started

Overview of Business Intelligence Cloud Connector  
You can use Oracle Business Intelligence Cloud Connector (BICC) to extract business intelligence and other data in bulk
and load it into designated external storage areas.

BICC is available as part of the Oracle Applications Cloud subscription. Additional access provisioning is required
and you must sign into BICC to perform all tasks related to the data extraction. Details about access provisioning are
provided in the Provision Access section.

After you sign into BICC, you can select the offerings from which to extract data, and also specify whether you want
to store the extracts on a dedicated external cloud storage or load them into Oracle Universal Content Management
(UCM). The extracted data is secure because the security standards applied to Oracle Applications Cloud extend to BICC
as well. Extracts run faster depending on what you extract and how. Let's look at what you can do with BICC to extract
data efficiently from the products available in your implementation:

• Configure an external storage location that works for your data needs.

• Extract complete or partial data. You can select offerings or specific objects.

• Run extracts on-demand or schedule them to run at specified intervals during the day, in a week, or throughout
the month.

• Run incremental extracts if you need only the data that changed since your last extract.

• Schedule multiple independent extracts at convenient intervals.

• Monitor extracts and review logs.

• Export configured offerings and associated data stores.

• Manage refresh metadata and specify dates for incremental refresh comparison.

Here's a simple illustration of the workflow for storing, running, and managing the extracts.

This chapter introduces you to BICC and covers some of the basic tasks required to set up BICC. The subsequent
chapters cover details about configuring and running the extracts, and managing the extraction process thereafter.

Note:  Use BICC to extract data from the data stores and store them in an external storage for future retrieval and use.
For details about downloading the data from external storage, refer to the external storage product documentation.
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Provision Access  

Overview of Access Provisioning  
Before you prepare data extraction from any of the Oracle Cloud applications, you must configure user credentials with
access to the BICC Console and the data files generated by BICC and store on the UCM server.

You need access to BICC to select offerings, identify what you want to extract, and specify where you want to store the
extracted data. You need access to the files stored on the UCM server so that you can view and download the extracted
data.

Access to BICC Console and UCM are provisioned through different roles. In the following topics, you will find details
about provisioning users for both BICC Console and UCM.

Provision a User with Access to BICC  
Set up a user who can access BICC. Below are details of how to create a custom role; you can also assign a user the BI
Administrator role, which also has BICC Console access.

Before you start
You must set up the access using the Security Console of Oracle Applications Cloud. Therefore, make sure you have the
Security Manager role assigned to you so that you can access the Security Console.

Here's what to do

1. Sign in to Oracle Applications Cloud and click Navigator > Tools > Security Console .
2. Click the Roles tab and click Create.
3. On the Basic Information page, enter the following values and click Next.

Field Value

Role Name BIACM_ADMIN

Role Code BIACM_ADMIN

Role Category BI - Abstract Roles

4. Click Next to navigate to the subsequent pages. You can skip entering details on the Function Security Policies and
Data Security Policies pages.

5. On the Role Hierarchy page, click Add Role.
6. On the Add Role Membership dialog box, search for the following roles and click Add Role Membership to add them.

◦ ESS Administrator Role: To create and manage schedules for global data extracts or jobs.

◦ ORA_ASM_APPLICATION_IMPLEMENTATION_ADMIN_ABSTRACT: To have access to global offerings
and data stores or jobs.

7. Close the Add Role Membership dialog box and click Next.
8. Skip entering details on the Segregation of Duties page and click Next.
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9. On the Users page, click Add User.
10.On the Add User dialog box, search for and select the user to whom you want to assign this role.
11. Click Add Selected Users and close the dialog box.
12. Click Next. Review the summary and click Save and Close.

Provision a User with Access to BICC Content on UCM  
Along with the access to BICC Console, you must also ensure that the user has access to the BICC generated content
that's stored on the UCM server.

Before you start
Make sure you have the Security Manager role assigned to you so that you can sign into the Security Console.

The extract files are stored in the OBIAImport security group on the UCM server. Use the Security Console of Oracle
Applications Cloud to provide the user with access to this security group.

Here's what to do

1. Sign in to Oracle Applications Cloud and click Navigator > Tools > Security Console .
2. Click the Roles tab and click Create.
3. On the Basic Information page, enter the following values and click Next.

Field Value

Role Name BICC_UCM_CONTENT_ADMIN

Role Code BICC_UCM_CONTENT_ADMIN

Role Category BI - Abstract Roles

4. Click Next to navigate to the subsequent pages. You can skip entering details on the Function Security Policies and
Data Security Policies pages.

5. On the Role Hierarchy page, click Add Role.
6. On the Add Role Membership dialog box, search for OBIA_EXTRACTTRANSFORMLOAD_RWD and click Add Role

Membership. This role membership is required to view and download the extract files on UCM.
7. Close the Add Role Membership dialog box and click Next.
8. Skip entering details on the Segregation of Duties page and click Next.
9. On the Users page, click Add User.
10.On the Add User dialog box, search for and select the user to whom you want to assign this role.
11. Click Add Selected Users and close the dialog box.
12. Click Next. Review the summary and click Save and Close.

Roadmap for the Cloud Extracts  
After the accounts are provisioned, you are ready to do the next steps to extract data.
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To provide a quick reference, the individual tasks are elaborated and tabulated here. You can use the task descriptions
as mapped points and go to the relevant topics for details.

Task Group Task Description

Get Started Sign in to BICC Use the provisioned account and sign in.

Set BICC Console Preferences Personalize the console as per your
preferences.

Review View Object to Database
Lineage Mappings

Review and understand how the BI view
objects and database lineages are mapped.

Implement Select BIVOs Select any of the offerings and select the
associated BIVOs.

Configure External Storage Select a storage location for the cloud extract
files.

Schedule an Extract Run an Extract Create an extract schedule or run data
extract for the selected BIVOs.

Schedule an Extract You can create and run multiple extract
schedules and data extracts.

Administer Monitor an Extract You can view last cloud extract and check
error messages in the case of failures. You
can check scheduled jobs’ logs to review
issues causing errors and get support to
resolve them.

Download extract files Download the extracted files from the
configured storage location.

Review Database Lineage Mappings and View Objects  
Before you extract data, you must know the BI View Objects (VOs) and their attributes. The data store guides describe
the view objects and attributes that can be used for extracting data out of your application instances.

Use the Extract Data Stores guides available for the following offerings:

• Oracle Fusion Cloud SCM Extract Data Stores for SCM

• Oracle Fusion Cloud Procurement Extract Data Stores for Procurement

• Oracle Fusion Cloud Financials Extract Data Stores for Financials

• Oracle Fusion Cloud Customer Experience Extract Data Stores for CX Sales and Fusion Service

You can also review the mapping of VOs to the corresponding database tables and columns available in lineage
spreadsheets hosted on the Oracle Cloud Customer Connect site.

Note:  Lineage only includes data stores that have predefined extract definitions and are shipped with Oracle Fusion
Cloud Applications. Non-standard data stores and attributes aren't available.
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To review the mappings, follow these steps.

1. Click the link here that corresponds to your offering and navigate to the Oracle Cloud Customer Connect portal.

◦ R13.x HCM BI Cloud Adapter BI View Object to Database Lineage Mapping Spreadsheet

◦ R13.x FSCM BI Cloud Adapter BI View Object to Database Lineage Mapping Spreadsheet

◦ R13.x CX BI Cloud Adapter BI View Object to Database Lineage Mapping Spreadsheet

2. On the Reporting and Analytics page for your product, review the information and click the link to the recently
published .zip file.

3. On prompt, download the .zip file to a location on your local computer.
4. Extract the contents of the .zip file. The extracted folder contains spreadsheets that list the mappings of the BI

VOs to database tables and columns.
5. Use the information in the spreadsheet to search for a View Object, the corresponding Database Table and

Database Column.

Tip:  Use the filters to narrow down and find names of the VOs that are required for your extracts.

To learn more about the tables and columns for the respective product areas, see the corresponding Tables and Views
guides.

Sign In To BICC  
Open any browser and enter < https://<saas cloud host name>:<saas cloud port number>/biacm>. Alternatively,
you can use the web link supplied to you by Oracle Cloud Support. Enter your credentials and sign in to BICC.

Preferences
Immediately after you sign in to BICC, set your preferences even before you start working with it. You can set
preferences such as regional settings, display language, and accessibility options.

1. On the panel tab, click Preferences.On the panel tab, click Preferences
2. Set these preferences:

◦ Click Regional to specify the date, time, number, and time zone details.

◦ Click Language to specify your preferred language.

3. Click Save.

Now you are ready to proceed with the data extracts.

Accessibility
To set your accessibility preferences:

1. Click the Accessibility icon on the global header of the BICC Console.
2. On the Enable Accessibility Preferences page, select the check boxes of the preferences you want to enable and

click Apply.
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2  Implement

Configure Where to Load Data  
Click the Configure External Storage button in the panel tab and select the Configure External Storage link to open
the Configure External Storage dialog box, where you can specify storage areas into which Cloud data is loaded.

For example, to load into one or more Oracle Cloud Storage Service instances, select the Storage Service Connection
Configuration tab. Select the OCI Object Storage Connection tab to configure Cloud Infrastructure connections, and
select the UCM Connection Configuration tab to configure Universal Content Management Server connections.

Storage Type — Cloud Storage Service
To specify the connection details for one or more Oracle Storage Service instances, click the name of a provisioned
connection or click Add to create a new connection. Click Delete to delete an existing connection.

Storage areas are associated with extract schedules. You can have as many Cloud Storage Service containers as are
required by your Cloud application integrations, but each should be used for its own requirements, so that there's no
overlap between them. Runtime metadata, including the last extract date, is managed across all storage locations, so
configuring the same data store in multiple schedules with different external storage configurations results in loss of
incremental data.

Use the following fields in the Storage Service Connection page to specify the connection details:

Field Name How to Use

Name Specify a name for the connection.

OAC External Storage Select this option if the connection is to an Oracle Analytics Cloud (OAC) storage service. You can
specify only one OAC storage service connection. Note that encryption is disabled for OAC storage.

Protocol Specify http for non-SSL, or https for SSL connection.

Host Specify the Host name for the Oracle Storage Service. For example,
 mystorage.storage.oraclecloud.com.

Port Specify the port number (optional).

User Name Specify the user that is provisioned to load data. The user should have privileges to upload files
in the container specified. User credentials will be stored in the Weblogic credential store under
oracle.apps.security/FUSION_APPS_OBIA_STORAGESERV_USER-KEY.

Password Specify the password for the user specified in the User Name field.

Service Name Specify the service name of the Oracle Cloud Storage Service. For example, gse-otbie1.

Container Specify the name of the container that is allocated to upload extracted files. Click Refresh button to
refresh the list of the containers. It's a good idea to check the storage service connection. Click Test
Storage Service Connection to verify succesful connection.
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Field Name How to Use

Data Encryption — Support Encryption If you want to encrypt communication, select this option and use the Import Certificate option to
specify the encryption keys.

Import Certificate Click Browse and navigate to and select the location of the key file, or type the literal path location and
file name.

Download Folder Shows the directory in the domain server where the Batch Extract file is downloaded to reset extract
dates before the extraction process.

Upload Folder Shows the directory in the domain server where files are temporarily extracted by the cloud extractor
before uploading to the storage service.

Storage Type — OCI Object Storage Connection
Use the following fields in the Configure External Storage page to specify the connection details:

Field Name How to Use

Name Specify a name for the connection. .

Host Specify host name. Host information is available inObject Storage Service API in the OCI API
Documentation.

Tenancy OCID Specify Tenancy OCID. To obtain the Tenancy and user OCID, refer to this to Where to Get the Tenancy's
OCID and User's OCID.

User OCID Specify User OCID.

Namespace Specify the namespace. Namespace is obtained in the OCI Console.

Bucket Specify the bucket into which extracts are uploaded. Bucket names are obtained in the OCI Console.

Generate API Signing Key Generate the required API signing key for OCI. The fingerprint is displayed after generation.

Export Public Key Export the public key for upload to OCI.

Test Connection Test the connection.

Storage Type — UCM
Review the connection details for Universal Content Management (UCM) using the following fields:

Field Name How to Use

Protocol Specify http for non-SSL, or https for SSL. If you select https here, you must also enable HTTPS on the
UCM server, using the UCM Server Console.

Host Shows the host name for the UCM Server. For example, myserver.companyname.com

8
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Field Name How to Use

Port Specify the port number of the UCM Server (optional). For example, 7012.

Test UCM Connection Test the UCM connection.

Download Folder Shows the directory in the domain server where the Batch Extract file is downloaded to reset extract
dates before the extraction process.

Upload Folder Shows the directory in the domain server where files are temporarily extracted by the cloud extractor
before uploading to UCM.

Create and Manage an Offering  
Click Actions > Create Offering in the Offerings dialog to open the Manage Offering dialog, where you can specify a new
offering and associate a data store.

Manage Offering

Field Name How to Use

Offering Code Enter a code for the offering.

Offering Name Enter a name for the offering. This is the name that will appear in the list of Business Intelligence
Applications Offerings in the Configure Cloud Extract dialog.

Offering Description Optionally, enter a description.

Associate Data Store
In the Associate Data Store section of the dialog, filter for the data store, then select and click the Move selected items
to other list button to add the VO, then click Save.

Add a Datastore for an Offering  
You can add a data store and specify its details for an offering.

1. On the Data Stores for Offering page, click the Add button.
2. On the Data Store Settings page, enter these details to specify a new data store for the selected offering.

Field Name How to Use

Data Store Key Enter a key for the data store. This is a mandatory
field and is used in the validation process.

Query Filter Enter a filter to restrict the returned data when
you run the query. All column references should

9



Oracle Fusion Cloud Applications
Creating a Business Intelligence Cloud Extract

Chapter 2
Implement

Field Name How to Use

follow the format underscore ( _ )underscore
( _ ) DATASTORE underscore ( _ ) underscore

( _ )dot(.)>BI VO Column Name>, for example
select __DATASTORE__.ViewApplicationId=0 where
ViewApplicationId is the column name in the BI VO
and of data type number. Similarly, to filter results
based on timestamp, you can follow the format
__DATASTORE__.CostDistributionLinesEOLastUpdateDate

>= TIMESTAMP '2019-01-15 07:45:00' where the results
are filtered as per the given parameter TIMESTAMP
'2019-01-15 07:45:00'. You can use the appropriate
operators such as = or >= to get the expected results.
If you don't enter Query Filter, the field displays
"(none)" after you save the details.

Note:  Filters up to 4,000 characters are supported.

 

Data Store Options ◦ Silent Error: When selected, errors on a data store that occur
during the extract are ignored. Deselect it if you want to
display the errors during the extract process.

Note:  The last extract date is set on a datastore only when a
datastore extract is successful. When Silent Error is enabled
and if the scheduled BICC extract fails, the files already
extracted for the data stores where extraction was successful
are preserved in spite of the extraction failure of other data
stores marked with silent error. But if this option is not selected
and the extract fails, the already extracted files are removed for
all data stores.

◦ Disable Effective date filter: Select this option to extract
all historical records, and not use the date filter. Note that
console allows setting this option on all datastores and is not
restricted to effective dated datastore. So, set this option only
after confirming the nature of the data.

◦ Extract Data Store Metadata: This option is selected by
default. When selected, this option generates an .mdcsv file
with the data extract.

◦ Use UNION ALL for incremental extract: Enable this if you
schedule incremental extracts.

3. In the Associate Offerings section, from the Available Offerings list, select the offerings you want to associate
with the data store. Click the Move button to move the selected items to the Selected Offerings list.

Tip:  You may double-click an offering in the Available Offerings list to move it to the Selected Offerings list.
Double-click an offering in the Selected Offerings list to reverse the selection.

4. Click Save. The details of the newly added data store appear.

To modify details of the newly added data store, click Edit Data Store Details. To define columns for extraction,
click Select Columns. The column definitions are retrieved from the BI repository.

For more information, refer to the topic Preview and Edit a Data Store for an Offering.
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Configure Extract Preferences  
Click Actions > Extract Preferences to open the Extract Preferences dialog, where you can specify preferences for
extracts.

Language
In the Preferred Extract Language field, select the language you'd prefer extracts be made in.

Prune Time in Minutes
To ensure data dependencies across objects are maintained during incremental extracts, you can set a prune time that
determines how long before the last extract date to extract data from. The default, 1,440 minutes or 24 hours, ensures
a look-back that works best for extracts with daily or higher reoccurrence. You should adjust prune time to a smaller
window if your extracts are scheduled more frequently or if any downstream system can handle objects extracted in any
order. In general, use prune time in accordance with the frequency of your extracts. If you run extracts hourly, set the
prune time to 60 minutes. If you run daily, leave it as the default of 1,440 minutes. If you don't need overlapping data to
manage early or late dependencies across data stores, you can set the prune time to zero.

Examples:

• With Pruning Time set to the default of 1440 minutes or 24 hours, a daily extract has 48 hours of data because
it includes data from 24 hours before the last extract date.

a. An extract runs on 7/28, so the last extract date is updated to 7/28.
b. Another extract runs 24 hours later on 7/29. It would filter for data from 7/27 forward, representing the

last extract date of 7/28 minus prune time of 24 hours. The extract would have data for 7/27 - 7/29, or 48
hours.

• If Pruning Time is set to zero, a daily extract has 24 hours of data.
a. An extract runs on 7/28, so the last extract date is updated to 7/28.
b. Another extract runs 24 hours later on 7/29. It would filter for data from 7/28 forward, representing the

last extract date of 7/28 minus prune time of zero hours. The extract would have data for 7/28 - 7/29, or
24 hours.

Job Settings
In the Timeout in Hours field, enter the number of hours before a job times out. The default is 10. By default, the job fails
on timeout. Deselect Timeout Force Fail if you prefer that timed out jobs not be failed.

Note:  If timed out jobs aren't failed, all data files for all data stores that were successful before the timeout are
uploaded to external storage.

File Parameters
In the Compression type field, select the type of compression you’d like to use. In the Split file size (GB) field, specify the
file size by which extracted CSV files are divided for a single VO. The default is 1 GB. You can set the file size from one to
five GB.
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In the Uploaded file expiry (Days) field, enter the number of days you’d like the extract files to persist.

File Parameters settings can be overridden at the schedule level when creating schedules and assigning external
storages to them.

External Storage
Select the Upload to Multiple External Storage option to increase the number of external storages that can be
selected in the External Storage list when creating or editing schedules. The default is one storage, and the maximum is
two.

Retry Parameters
During extraction, connections to the BI Server or queries may fail, causing retries. In the Analytic server connection
retry limit field, specify the number of connection attempts made to complete the extraction. In the Analytic server
query retry limit field, specify the number of times a query is resubmitted.

The Analytic server connection retry limit setting can be overridden at the schedule level when creating schedules and
assigning external storages to them.

Global Extract Schedule Notification
To send notifications when scheduled extract events occur, select the notifications you want upon extract start, success,
or failure. In the Mail To Addresses, enter email addresses, separated by commas, to which you want notifications sent.

Global Extract Schedule Notification settings can be overridden at the schedule level when creating schedules and
assigning external storages to them.

Configure Flexfield Label Languages  
Click Actions > Configure Flex Label Languages in the Offerings dialog to open the Configure Flex Label Languages
dialog, in which you can specify a language for flex labels.

In the Flex Label Languages list, scroll to select the language you want, then click the Move selected items to other
list button to add it to the selected list, then click Save and Close. To suspend extraction of flexfield labels during
extraction, select the Suppress Flex Label Extract option.

Configure Offerings to Extract  
You can select offerings that you want to extract, specify VOs from which to extract data, and set up once-only or
regular data extracts in the Offerings dialog box.

Click the Manage Offerings and Data Stores button in the panel tab and select the Manage Offerings and Data
Stores link to open the Offerings dialog box.

12
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Offerings

Field Name or Option How to Use

Offerings list View the offerings that are available for extraction. Click an offering to view and configure its data
stores.

Search Enter an offering name and click Search to locate it in the list.

Actions > Create Offering Create a new offering and specify its VOs.

Actions > Reset Last Extract Date Specify the last extract date from which extraction should begin for incremental loads.

Actions > Configure Flex Label Languages Specify a language for flexfield labels.

Actions > Extract Preferences Specify extract parameters, including: job timeout; CSV file size to split files by; retry parameters in
case of intermittent BI Server connection or query failures; and extract schedule email notification
frequency and recipients.

List View View the Offerings list as a list with Actions icon for each offering.

Grid View View the Offerings list as a grid with Actions icon for each offering.

Offering Action > Delete Delete the currently selected offering and its corresponding VO association. Available only for user-
defined offerings.

Offering Action > Edit Change the Offering Name and VO association of the currently selected offering.

Offering Action > Reset to Shipped
Content

Reset the offering to shipped content, removing any changes made.

Offering Action > Reset to Full Extract Reset the last extract date so that a full data load is performed for the offering, instead of an
incremental load. You typically use this option if your business requirements have changed or when
fact data has been corrupted.

Offering Action > Reset All Data Stores To
Shipped Content

Reset all the mapped data stores to the shipped content, removing all changes made until that point.

Click the Manage Offerings and Data Stores button in the panel tab and select the Export Modification link to collect
modification information from the source environment and export it as compressed CSV files. The source file returns all
values in string format and it is enclosed in double quotes whether the data has null or empty value.

Export or Import Customization is used to export or import all user customized metadata from one environment to
another of the same version. You can export all jobs or a specific job. To export a specific job, click Manage Offerings
and Data Store  button and select Export Modification. On the Export Modification dialog box, click the Jobs
checkbox, select the specific job from the list, and click OK.

Select the Import Modification link to apply modifications to the destination environment using the exported
compressed CSV files. On the Import Modification dialog box, click Browse and select the exported files, and click
Import.

Note:  If you reset all data stores at the offering level before performing the import, the PVOs attain the schema
definition of the imported files.
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Data Store for Offering: Offering name
Click an offering in the Offerings list open the Data Store for Offering: Offering Name page, where you can specify View
Objects VOs from which to extract data.

Field Name or Option How to Use

Data Stores list View the data areas that are available for extraction for the offering you clicked.

View > Columns Select columns to be displayed in the Offerings list.

View > Detach Pop out the section of the dialog box so you can see more data.

View > Reorder Columns Change the display order of the columns in the Data Stores list.

View > Query By Example Filter the displayed results by entering the first few letters of a name.

Add Specify a new Data Store for an offering. For example, you might want to add a view object (VO) for
extraction. To add a VO, in the wizard’s Datastore details page, provide the VO name, then specify
whether you want to disable effective data filter, which allows for extraction of all historical records, if
required. Enter any required query filter, using column references following the format __DATASTORE_
_.<BI VO Column Name>. In the wizard’s Select Columns page, select the column types for the
select query from the Column Filter list, then uncheck the columns you don’t want included in the
SELECT list. If the VO is defined as Effective Date Disabled, you can select the Natural Key option for a
Primary Key Column to define a natural key.
To add a user-defined data store, enter the name of the VO and provide the name of its Available
Offering. When you select the columns, select the primary key for the VO. It will now appear with the
predefined VO's.
 

Remove Delete the currently selected Data Store.

Refresh Refreshes the Data Store list.

Query by Example Filter the displayed results by entering the first few letters of a name.

Detach Pop out the section of the dialog box so you can see more data.

Actions > Reset to Full Extract Reset the last extract date so that a full data load is performed at the next load for the data store/
VO, instead of an incremental load. You typically use this option if your business requirements have
changed or if fact data has been corrupted.

Actions > Reset to Shipped Content Reset the VO to shipped content, removing any changes made.

Actions > Export Metadata Definition
(MDCSV)

Export metadata definition for the data store in the MDCSV format. The selected data store content is
exported into a zip file that you can download.
Here's some additional information about this format:

• File extension: .mdcsv

• Delimiter: ||| (three vertical pipes)

• Includes Primary Key columns: Yes

• Includes Incremental columns: No

• Includes Select List columns: No

You can extract the metadata definition in this format when you run the data extracts.
 

Actions > Export Metadata Definition
(CSV)

Export metadata definition for the data store in the CSV format. The selected data store content is
exported into a zip file that you can download.
Here's some additional information about this format:
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Field Name or Option How to Use

• File extension: .csv

• Delimiter: , (comma)

• Includes Primary Key columns: Yes

• Includes Incremental columns: Yes

• Includes Select List columns: Yes

You can't extract the metadata definition in this format when you run the data extracts.
 

Actions > Export UI Label Export user interface labels for the VO. A zip file is generated with files for each configured language.

Actions > Download Sample CSV File Verify the sample extract from the selected data store.

Actions > Advanced Extract Configuration Specify initial extract date and chunking for creation date and primary key for full loads.

Actions > Manage Extract Mode Specify the extract mode. When BI Broker extract mode is enabled, extract jobs don't use the BI Server.
They interact directly with data stores and the Cloud Applications source database. To enable it, select
BI Broker extract mode in the Manage Extract Mode dialog and click OK. A check is then performed to
verify that BI Broker mode is supported for the data store, and if not an error is displayed.

Last Extract Date View the date and time when the Data Store was last extracted.

Click the Configure Cloud Extract button in the panel tab and select the Review Cloud Extract Configuration link to
return to the Enabled Data Stores dialog box.

Broker Extract Mode
BI Broker extract mode is supported for some data stores, and can be set at the data store, schedule, and job levels.
When you set the mode, any affected data stores are verified for Broker mode support. If there's no error, the included
data stores using the mode are extracted independently of the BI Server metadata, with extract queries running directly
against the data stores in the Oracle Applications Cloud database, which can help extract performance.

New and Deprecated Data Stores
After an update, new and deprecated VOs are documented so that you can add new VOs and columns to your extracts
and remove any that aren't available. For more information, see R13.x Deprecated and New BI View Objects.

Perform Advanced Extract Configuration  
You can set advanced extract configurations when you run full extracts. You can use advanced extract configuration
settings when you extract numeric or CLOB data types.

1. On the Data Store for Offering page, use Actions > Advanced Extract Configuration for a data store to open
Advanced Extract Configuration.

2. In the Advanced Extract Configuration page, you can set advanced extract configurations for a selected data
store. For full extracts, you can enable chunking by creation date or by primary key.
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Filter and/or Chunk By Creation Date Columns

Field Name How to Use

Initial Extract Date Optionally, specify the initial date from which the full extract should be performed. This option requires
selection of the Is Creation Date option for a column or columns in the column list, which represent the
Creation Date.

Support chunking Optionally, select By Creation Date to chunk by to specify a number of days by which to extract date
range batches or chunks of data. This option requires selection of the Is Creation Date option for a
column or columns in the column list, which represent the Creation Date.

Number of Days If you selected to support chunking by creation date, specify the number of days, for example 365, by
which to chunk extracts.

Columns View the columns that are available for designation as creation date. Select the Is Creation Date option
for the appropriate column.

Chunk By Primary Key Column

Field Name or Option How to Use

Support chunking Support chunking by numeric primary key. This option requires a single numeric primary key column
for the data store.

Number of Rows Specify a number of rows to chunk extracts by.

Extract as String
In the Extract as String tab, you can select columns that are of numeric or CLOB data types for conversion. Select the
Cast to String checkbox to extract numeric columns with more than 15 digits and CLOB data types. This setting trims
the CLOB data to the character string limits supported by VARCHAR datatype. This isn't a data transformation. Data
transformations, including data format customizations, aren't supported by BICC.
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3  Schedule Extracts and Jobs

Specify When to Run Global Extract Jobs  
You can set up and monitor once-only or regular data extract jobs – for example, once per day at midnight – for
Business Intelligence data from an Oracle Applications Cloud data source in the Manage Extract Schedules dialog box.

Click the Manage Extract Schedules button in the panel tab and select the Manage Extract Schedules link to open the
dialog box.

Field Name How to Use

Schedules This list shows schedules submitted in the last 24 hours. Use the Add option to set up once-only or
regular data extract. Use the Delete Schedule option to delete the currently selected schedule. Click a
schedule's name to preview or edit its details. In the Schedule Details, click the Edit option to update
the details of the currently selected schedule. Use the Switch to BI Broker Extract option to apply BI
Broker mode to the schedule. This changes the extract mode of all the data stores in the schedule.

Note:  When you change a schedule to BI Broker mode, all of its data stores use that mode. This
allows you to set the mode for multiple data stores, but BICC won't validate the mode using this
option. The implementer has to validate the status after the schedule is updated. BI Broker mode
doesn't support all data stores. It's strongly recommended that you set the mode at the the data
store level and test before implementing the mode for all data stores in a schedule.

It’s recommended that you periodically purge the Schedules list, as not all completed schedules are
shown. To do this, use the Delete Inactive Schedules option.
 

Schedule Requests This list shows the details of data extract processes for the Schedule that's currently selected in the
Schedules list. A new row is created in the table every time an Cloud extract request is processed. Use
the Delete option to delete the details of the currently selected request. If you delete a schedule job
from this list, it doesn't remove the BI Cloud data that's been extracted and loaded by that job.

Monitor a Cloud Extract
In the Schedules dialog, click Actions and select the option for the last run corresponding to the job type, Cloud Data
Extract or Deleted Record Extract. Each job type displays in its own dialog, which lists the last cloud extract or deleted
record extract status of each VO with status of SUCCESS or FAILURE for each data store and error messages in the case
of failures. The ESS Request Id column displays the job for which the VO extraction last ran.

Scheduled jobs also write logs that can be used to review issues causing errors or shared with Oracle Support to resolve
a service request. To download logs, click Help and select Download Logs.

For scheduled jobs, whether successful or not, an extraction status file in JSON format is uploaded to external storage.
The files have a default expiration date, and have the following file name format, depending on job type:

• Cloud Data Extracts:EXTRACT_STATUS_DATA_SCHEDULE_<Schedule Id>_REQUEST_<request_id>.JSON

• Deleted Record Extracts:EXTRACT_STATUS_DELETED_SCHEDULE_<Schedule Id>_REQUEST_<request_id>.JSON
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Column Content

Name VO name

status VO extract status

errorMessage If extract failed, any resulting error status

runDate Run date of the extract of the VO

queryDurationInSec Time the query took to run, in seconds

extractDurationInSec Time the extract of the query results took, in seconds

uploadDurationInSec Time the upload to external storage took, in seconds

totalDurationInSec Total duration of the job

rowCount Number of rows extracted

Create a New or Edit an Existing Data Extract Schedule  
In the Manage Extract Schedules dialog, click Add or Edit to create a new Cloud data extract or edit an existing one. For
example, you might want to extract data from your Cloud data source once per day at midnight.

For a once-only data extract, use the Simple option in the Recurrence list. You can only create a schedule if there isn't
an active schedule for the selected job type (for example, Cloud Data Extract, Deleted Record Extract, or Data and Delete
Record Extract). Click Next to specify the data stores for extract for an offering in the Data Store List page.

Schedule Details

Field Name or Option How to Use

Job Type To extract data, select Application Data Extract. Application Data Extract supports incremental
extracts after the last successful extract. To manage deleted records, select Active Primary Key
Extract, which extracts all primary key values to identify deleted records. To combine both Application
Data Extract and Primary Key Extract into one job, select Application Data and Active Primary Key
Extract.
 
To purge expired files from Universal Content Management (UCM), select Delete Expired UCM Files.
When a file is extracted and uploaded to UCM, it has a default expiration of 90 days. Expired files are
soft deleted from UCM and may eventually require purging to preserve space. The job deletes only
expired files from the OBIAImport security group.
 
Ensure you don’t use UCM as a repository to archive all the extracts. If you don’t delete the files
periodically, the UCM storage can experience space management issues. Deleting files over longer
period does not scale in UCM.
 
You must have a workflow to purge the files in UCM after you’ve downloaded them. You can use BICC
job Delete Expired UCM Files for this action.
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Field Name or Option How to Use

To delete all of the files uploaded to one or more selected external storages, select Delete Files in
Storage. For a storage service, this job deletes all files from the container associated with the external
storage. For UCM, it deletes all file uploaded to the OBIAImport security group.
 

Name Specify a short name to identify the schedule in the Schedules list.

Description Specify a brief description to identify the schedule, which is only displayed on the Edit Schedule dialog.

Global Data Store List Accept the default of No to select data stores for extraction. Select Yes to use the Global Data Store.

Recurrence Specify how often you want the extract to be performed. To create a once-only data extract, select
Simple.

Hourly Interval Specify the number of hours to perform hourly interval extracts by (if you select Hourly in the
Recurrence list).
 
Use hourly extracts with caution. The total extract time depends on the selected datastore design
and must be tested by the implementer. Hourly extract adds load on Fusion database and is not
recommended.
 

Date and Time Specify the date and time to perform a once-only extract (if you select Simple in the Recurrence list).

Time Specify the time to start an extract, in the format HH:MM:SS AM|PM. For example, 3:00:00 AM.

Day For weekly schedules, select the check box next to each day on which you want to extract data. For
Monthly or Yearly extracts, select the day of the month on which you want to extract data.

Month For Yearly (annual) schedules, select the month in which you want to extract data.

Data Store List

Field Name or Option How to Use

Offering Select an offering to extract.

Data Store List Lists the data stores for a selected offering.

Enabled for Extract Select to enable a data store for extract.

Query By Example Filter the displayed results by entering the first few letters of a name.

Detach Pop out the section of the dialog box so you can see more data.

External Storage
For seamless integration, you can configure a schedule to use application-specific storage service containers, allowing
you to schedule extracts for multiple integrations.
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Note:  To optimize the extraction flow and force reuse of the extracted data files across integrations, it’s preferable
that separate storage containers be used when there's no overlap on the data stores required for each integration.
Runtime metadata, including the last extract date, is managed across all storage locations, so configuring the same
data store in multiple schedules with different external storage configurations results in loss of incremental data.  If
an overlap on the data stores is required, you can enable advanced extract options for extract jobs to upload the same
data files to two separate external storage locations. To do this, select the Upload to Multiple External Storage option
in the Extract Preferences dialog box.

Field Name or Option How to Use

External Storage For extracts, select a data store to upload the extract to. By default, you can select one. If the Upload to
Multiple External Storage option is selected in your extract preferences, you can select two data stores
if an overlap of the data stores is required.
 
If you’re deleting expired UCM files, the UCM external storage is selected. If you’re deleting files in
storage, select one or more from the list of external storages to delete.
 

Notification Select one of the following options: Use Global Extract Notification to use the global settings defined in
the Extract Preferences dialog box; Define Notification to set notifications for the schedule and override
the global settings; or None. the notifications you want upon extract start, success, or failure. In the
Mail To Addresses, enter email addresses, separated by commas, to which you want notifications sent.

Notify On If you have selected Define Notification for the schedule, select the notifications you want upon extract
start, success, or failure.

Mail to Addresses Enter email addresses, separated by commas, to which you want notifications sent.

Use Global File Parameters Select Yes to you use the global file parameter settings defined in the Extract Preferences dialog box.
Select No to set parameters for the schedule and override the global settings.

Compression Type Select the type of compression you’d like to use for the schedule.

Split file size (GB) Specify the file size by which extracted CSV files are divided for a single VO for the schedule. The
default is 1 GB. You can set the file size from one to five GB.

Uploaded file expiry (Days) Enter the number of days you’d like the extract files to persist for the scheduled extract.

Preview and Edit a Datastore for an Offering  
You can view the details of the existing data stores. If there are any changes, you can modify them and plan to re-
extract, if necessary.

Preview a Data Store
1. On the Manage Offerings and Data Stores tab, click the Manage Offerings and Data Stores link.
2. On the Offerings page, from the list of offerings, click an offering for which you want to view the data stores.
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3. On the Data Stores for Offerings page, click a data store to view the data store information.

You can view the following information:

◦ Data store code.

◦ Query filter

◦ Data store options

◦ Associated offerings

◦ Data store columns for which the attributes such as incremental key, primary key, and so on are set

Edit Data Store Details
Click the Edit Data Store Details button to edit the saved data store details. You may modify the query filter, select or
deselect the data store options, including whether to use Broker Mode for Extract, and change the list of offerings. You
can also download the sample CSV file to preview, if required. Save the edits you make before leaving the page.

Select Columns
Click the Select Columns button to modify the list of selected columns that are to be included in the extract. On the Data
Store Column Selection page, you can select the columns and make modifications using the various options available.
These are explained here:

• Select the check box in the Include column to select a data store column. Selecting the check box in the Primary
Key column automatically selects the check box in the Include column.

• Use the Search Column Names field to enter specific keywords and filter the list of columns.

• Use Filter to filter results by various column types. By default, it's set to Show All. Here is a brief description
about the other filter options:

◦ Date Type Columns: Filters and displays columns that have TIMESTAMP as the data type. For such
columns, the extracted data might store a detailed timestamp value.

◦ Varchar Type Columns: Filters and displays columns that support data of type varchar.

◦ Numeric Type Columns: Filters and displays columns that contain only numeric data. These columns
mostly contain various IDs that are generated or assigned.

◦ Primary Key Columns: Filters and displays columns that are primary keys.

◦ Incremental Key Columns: Filters and displays columns that store incremental keys.

◦ Deprecated Columns: Filters and displays deprecated columns, if any.

• Click the Select list to make bulk selection or deselection of columns. Use Revert to undo the last select all or
unselect all action.

• Click Actions > Retrieve PK to reset the primary keys.

Once you make all the changes, click Save. The columns that you select here for inclusion appear on the Data Store
Details page.
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Add a Job  
You can create jobs, specify and manage their data stores, and schedule and run them using refresh metadata at the job
level, isolating them from global refresh dates and allowing for overlapping extracts of the same data stores.

1. Click the Manage Jobs panel tab and click the Manage Jobs link.
2. On the Manage Jobs page, click the Add button.
3. On the Add Jobs page, enter these details to create a new job and manage its refresh metadata.

Field Name How to Use

Name Enter the name of the job.

Description Enter a description of the job.

Offerings From the list, select the offering that contains the data
stores you want to include in the job.

Enabled for Extract Select the check box for the data store that you want
to enable for extract.

4. Click Save. The job is added and the page navigates to the Manage Jobs page.
If you want to modify the job details, click the job name. The Job Details page appears where you can do the following:

• To edit details of the job, click the Edit button. On the Edit Job page, you can modify the job details. For more
information on modifying the job details, refer to the topic Manage Job Data Stores.

• To modify the data store details, click the data store name. You are taken to the page where you can modify the
data store details. For more information on modifying the data store details, refer to the topic Preview and Edit
Job Data Stores.

Manage Jobs
Jobs allow you to extract data from Oracle Applications Cloud to support multiple downstream integrations. All
data stores' metadata is managed at the job level. Different jobs may be used for different requirements, and run on
whatever schedule is needed, including running different jobs with the same data stores running at the same time.

You can use different frequencies and columns in your jobs. For example, you a Payroll Manager might run a monthly
job on a larger set of columns, while a payroll team member might run a more limited weekly extract. If there's a single
downstream target for the extracted data, use Manage Extract Schedules.

In this example, there are four columns, A, B, C, and D. The monthly job extracts B, C, and D, while the weekly job
extracts A and B. This can be done in two ways, with different query impacts on Oracle Applications Cloud that should
be considered when planning jobs. It's important to consider the costs of multiple extracts on Oracle Applications Cloud.

• You can extract all four columns every time and split the extracted data in the destination system without
impacting Oracle Applications Cloud transactional processing.

• If your destination system doesn't have the ability to split the data into sets of B, C, and D and A and B, then
you can create two different jobs, one for each case. This approach causes two queries on Oracle Applications
Cloud.
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Use these options to manage the jobs you add:

Field Name How to Use

Jobs list View the extract jobs that are available for extraction. Click a job link to view the job definition and
configure its data stores.

View > Columns Select columns to be displayed in the Jobs list.

View > Detach Pop out the section of the dialog box so you can see more data.

View > Reorder Columns Change the display order of the columns in the Jobs list.

View > Query By Example Enter the first few letters of the search string and press Enter.

Add Specify a name, description for the job, and data stores. The data store metadata definitions are copied
to the new job definition.
 
If the data stores have been modified at the global level, the modified versions of the metadata are
picked.
 

Delete Delete the currently selected job.

Refresh Refreshes the Jobs list.

Detach Pops out the table into a separate dialog box to provide better view of the contents.

Query By Example A shortcut button for the same feature that's available in View > Query By Example.

Actions > Copy Copy the selected job definition. Schedules for the job aren’t copied.

Actions > Reset to Full Extract Reset the last extract date so that a full data load is performed at the next load for all data stores/VOs
selected for the job, instead of an incremental load.

Actions > Reset Last Extract Date Rest the last extract date for all the data stores within the job.
 

Actions > Manage Initial Extract Date Specify the initial extract date for all the data stores in the job that have at least one creation date
column.

Actions > Manage Batch Mode Preferences Specify whether to run the job in batch mode. By default, all data stores defined in a job definition have
the Silent Error flag enabled. To turn off the Silent Error flag for all job data stores, set the job to batch
mode.

Actions > Manage Extract Mode Select BI Broker extract mode to apply it to the job. This changes the extract mode of all the data stores
in the job.

Note:  When you change a job to BI Broker mode, all of its data stores use that mode. This allows
you to set the mode for multiple data stores, but BICC won't validate the mode using this option. The
implementer has to validate the status after the job is updated. BI Broker mode doesn't support all
data stores. It's strongly recommended that you set the mode at the the data store level and test
before implementing the mode for all data stores in a job.

Manage Job Schedules
Use these options to view and manage your job schedules:
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Field Name How to Use

Search Use the Job list to filter for specific jobs and the Submission Time After field to decrease the
submission time window displayed in the Schedules and Schedule Requests lists. The schedules for the
last 24 hours are displayed by default.

Schedules list This list shows currently defined schedules. Use the Add option to set up a one-time or recurring data
extract job schedules. Use the Edit option to update the details of the currently selected schedule. To
delete a schedule, cancel it and then use the Delete option to delete it.

Schedule Requests This list shows the details of data extract processes for the Schedule that's currently selected in the
Schedules list. A row in this table corresponds to an ESS request. For a recurring schedule, there will be
multiple rows. For each row, you can click the State of the request to download the ESS log. Select the
View All Runs checkbox to view all the ESS requests corresponding to the schedule.
Use the Delete option to delete the details of the currently selected request. If you delete a schedule job
from this list, then this doesn't remove the BI Cloud data that's been extracted and loaded by that job
 
.

Manage Job Data Stores  
Click a job in the Jobs list open the Job Details: Job Name page, where you can view and specify data stores from which
to extract data. Modify the job data store details as required.

Job Details: Job name

Field Name or Option How to Use

Edit Edit job name, job description, and job data stores.

Edit Group Edit the order of execution within the job. Select the group number and specify group item priority for
each data store.

Done Close the dialog box and return to Manage Jobs.

Actions > Compare Shipped Metadata Compare shipped data store metadata with modified metadata side-by-side. Available for data stores
that are part of a job profile.

Actions > Reset to Full Extract Reset the last extract date so that a full data load is performed at the next load for the data store/VO,
 instead of an incremental load.

Actions > Reset to Shipped Content Reset all the data stores in the job to shipped content.

Actions > Export Metadata Definition
(MDCSV)

Export metadata definition for the data store in the MDCSV format. The selected data store content is
exported into a zip file that you can download.
Here's some additional information about this format:

• File extension: .mdcsv

• Delimiter: ||| (three vertical pipes)

• Includes Primary Key columns: Yes

• Includes Incremental columns: No

• Includes Select List columns: No

You can extract the metadata definition in this format when you run the data extracts.
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Field Name or Option How to Use

 

Actions > Export Metadata Definition
(CSV)

Export metadata definition for the data store in the CSV format. The selected data store content is
exported into a zip file that you can download.
Here's some additional information about this format:

• File extension: .csv

• Delimiter: , (comma)

• Includes Primary Key columns: Yes

• Includes Incremental columns: Yes

• Includes Select List columns: Yes

You can't extract the metadata definition in this format when you run the data extracts.
 

Actions > Export UI Label Export user interface labels for the VO. A zip file is generated with files for each configured language.

Actions > Download Sample CSV File Verify the sample extract from the selected data store.

Actions > Advanced Extract Configuration For full extracts, use Advanced Configuration to apply a filter or chunk. Select the Cast to String
checkbox in the Extract as String tab to extract numeric or CLOB data types. This setting supports
CLOB data up to the character string limits supported by the VARCHAR datatype. If data is larger than
the string limit, the extract fails. Data transformations, including data format customizations, aren't
supported by BICC.

Actions > Manage Extract Mode Specify the extract mode. When BI Broker extract mode is enabled, extract jobs don't use the BI Server.
They interact directly with data stores and the Cloud Applications source database. To enable it, select
BI Broker extract mode in the Manage Extract Mode dialog and click OK. A check is then performed to
verify that BI Broker mode is supported for the data store, and if not an error is displayed.

Preview and Edit Job Data Stores  
On the Job Details page, you can modify the job details. You can also view or modify the details of the associated data
stores.

Edit Job Details
1. On the Job Details page, click the Edit button.
2. Modify the job name and description, if required.
3. To add or remove offerings, click the Offerings list and select or deselect the Enable for Extract check box for

the identified offerings.
4. Click Save.

Edit Job Data Store Details
1. On the Job Details page, click the data store name that's listed in the Data Store column. The link opens the

data store page.
2. Click Edit Data Store Details. On the Data Store Settings page, you can do the following:

◦ Click the Download Sample CSV File to validate the data store and download a sample CSV file.
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◦ Add or modify the Query Filter.

Note:  Filters up to 4,000 characters are supported.

◦ Select or deselect the Data Store Options.

3. Click Save.

Select Columns
1. On the Job Details page, click the data store name that's listed in the Data Store column. The link opens the

data store page.
2. Click Select Columns. On the Data Store Column Selection page, you can do the following:

◦ Click the Download Sample CSV File to validate the data store and download a sample CSV file.

◦ Include or exclude the data store columns based on your extract preferences.

3. Click Save.

Customize Job Data Stores  
Click Customize in the Preview Data Store dialog box to open the Customize Job Data Store for job: Job Name dialog
box. All modifications for a data store are stored for the current job.

Customize Data Store for Job

Field Name or Option How to Use

Silent Error Default is to use silent error. Deselect to allow errors.

Disable Effective Date Filter Enable this option if there's a requirement to extract all historical records. Note that the VO not
validated as being effective dated in nature, so set this option only after confirming the nature of the
data

Extract Data Store Metadata Enable this option to extract data store metadata with the job, for example attribute definitions.

Use UNION ALL for incremental extract The default incremental extract strategy is to use OR. Select this option to use UNION ALL.

Query Filter Specify a query to filter the data.

Support Chunking Chunk data for large data VOs, splitting the output into chunks by initial extract date, creation date,
 or primary key. Set an Initial Extract date to filter data on that date for data store columns defined as
Creation Date, and select the preferred chunking option in the Support Chunking list.

Note:  Silent Error ignores the errors on a VO during an extract. When Silent Error is enabled and the scheduled BICC
extract fails, the PVO files already extracted by the same schedule are preserved inspite of the BICC extract failure.
On the contrary, if Silent Error is disabled and the scheduled BICC extract fails, the PVO files already extracted by the
same schedule are removed.
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Add a Job Schedule  
Click the Manage Jobs button and select the Manage Job Schedules link to open the Manage Job Schedules dialog
box, where you can manage job level schedules.

Manage Job Schedules

Field Name or Option How to Use

Schedules list This list shows currently defined schedules. Use the Add option to set up once-only or regular data
extract. Select a schedule to view or update its details. Click the Cancel Schedule button to cancel a
scheduled extract, and the Delete Schedule button to delete the currently selected schedule.

Schedule Requests list This list shows the details of data extract processes for the Schedule that is currently selected in the
Schedules list. A new row is created in the table every time a Cloud extract request is processed. Use
the Cancel option to cancel a scheduled run or delete the details of the currently selected request. If
you delete a scheduled job from this list, the data that's been extracted and loaded by that job isn’t
removed.

In the Manage Job Schedules dialog box, click Add to create a new Cloud data extract or click a schedule to preview an
existing one and edit it if it’s a recurring schedule.

Field Name or Option How to Use

Job Specify the job you’re creating the schedule for.

Name Specify a short name to identify the schedule in the Schedules list.

Job Type To extract data, select Application Data Extract. To sync the job data stores to your source data, select
Active Primary Key Extract, which extracts primary key values to identify deleted records. To combine
both Application Data Extract and Active Primary Key Extract into one job, select Application Data and
Active Primary Key Extract.
 

Description Specify a brief description to identify the schedule.

External Storage Select the external storage for the schedule.

Recurrence Specify how often you want the extract to be performed. To create a once-only data extract, select
Simple.

Hourly Interval Specify the number of hours to perform hourly interval extracts by (if you select Hourly in the
Recurrence list).

Date and Time Specify the date and time to perform a once-only extract (if you select Simple in the Recurrence list).

Time Specify the time to start an extract, in the format HH:MM:SS AM|PM. For example, 3:00:00 AM.

Day For weekly schedules, select the check box next to each day on which you want to extract data. For
Monthly or Yearly extracts, select the day of the month on which you want to extract data.

Month For Yearly (annual) schedules, select the month in which you want to extract data.

27



Oracle Fusion Cloud Applications
Creating a Business Intelligence Cloud Extract

Chapter 3
Schedule Extracts and Jobs

Field Name or Option How to Use

Notification Select one of the following options: Use Global Extract Notification to use the global settings defined in
the Extract Preferences dialog box; Define Notification to set notifications for the schedule and override
the global settings; or None. the notifications you want upon extract start, success, or failure.

Notify On If you have selected Define Notification for the schedule, select the notifications you want upon extract
start, success, or failure.

Mail to Addresses Enter email addresses, separated by commas, to which you want notifications sent.

Use Global File Parameters Select Yes to you use the global file parameter settings defined in the Extract Preferences dialog box.
Select No to set parameters for the schedule and override the global settings.

Compression Type Select the type of compression you’d like to use for the schedule.

Split file size (GB) Specify the file size by which extracted CSV files are divided for a single VO for the schedule. The
default is 1 GB. You can set the file size from one to five GB.

Uploaded file expiry (Days) Enter the number of days you’d like the extract files to persist for the scheduled extract.

Monitor Extracts
In the Schedules list, click Actions and select the option for the last run corresponding to the job type, Application Data
Extract or Active Primary Key Extract. Each job type displays in its own dialog box, which lists the last extract status of
each VO with status of SUCCESS or FAILURE for each data store and error messages in the case of failures. The ESS
Request Id column displays the job for which the VO extraction last ran. You can also select a job in the Job list to filter
the results.

View Last Run Status for a Cloud Data Extract  
In the Manage Extract Schedules dialog, click Actions and select a last run status for a run type to view logging and
status for each VO for the last extraction job for each, indicated by the ESS Request Id.

Click Detach to expand the dialog to full size.

Statuses
The status for each data store is displayed in the Status column. In the event of an error, the error message is displayed
in the Message column. Status includes:

• ERROR: Extract failed with the error message displayed in the Message column.

• EXTRACT_SUCCESS: Extract ran successfully.

• UPLOAD_SUCCESS: Upload to external storage ran successfully.
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View Last Run Status for a Deleted Record Extract  
The Last Run Status for Active Primary Key Extract dialog provides logging and status for each VO for the last extraction
job for each, indicated by the ESS Request Id.

In the Manage Extract Schedules dialog, click Actions and select Last Run Status for Active Primary Key Extract to
open the dialog. Click Detach to expand the dialog to full size.

Statuses
The status for each data store is displayed in the Status column. In the event of an error, the error message is displayed
in the Message column. Status includes:

• ERROR: Extract failed with the error message displayed in the Message column.

• EXTRACT_SUCCESS: Extract ran successfully.

• UPLOAD_SUCCESS: Upload to external storage ran successfully.

Reset Last Extract Date For All Enabled Data Stores  
Click Actions > Reset Last Extract Date in the Offerings dialog to open the Reset Last Extract Date For All Enabled Data
Stores dialog.

Specify the last extract date from which extraction should begin for incremental loads for the selected Offering. You
typically use this option if your business requirements have changed or when fact data has been corrupted. Click OK to
reset.
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4  Administer

Manage Files in External Storage for Custom Warehouse
Integration  
During an extract, view object (VO) data in compressed files is uploaded to an external storage with a manifest file that
lists the uploaded files from the current batch. Use the information in the manifest file to process data.

For a custom warehouse implementation, you must manage the manifest file and its contents. This section explains the
types of files that BICC generates and their properties.

Files Uploaded to External Storage
BICC generates the following files:

File Type Description Extension

Application Data Files Comma-separated value data files that contain
extracted BIVO data, and are uploaded as
compressed files.

.csv

Metadata Files Comma-separated value files that contain
metadata with details about columns and data
type definitions for Data Stores (BIVOs).

.mdcsv

Primary Key Extract Files Comma-separated value data files that contain
data from primary key columns. You can use
this data to delete records in your downstream
application, such as a warehouse.
 

.pecsv

Manifest Files These files contain information about the
uploaded files.

.mf

Tip:  You may notice when comparing Application Data Files and Primary Key Extract Files that they may have
different row counts. The reason for this is that normally, an extract includes all data store attributes, so all tables
related to them are included. In the case of a primary extract, only primary key attributes are selected in the extract
query, so a subset of rows are included from the tables.
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Note:
• The .csv, .pecs, and .mdcdv files and are individually zipped. For example,

‘file_crmanalyticsam_budgetam_budget-batch1510381061-20190517_004657_<time in milli secs>.zip’. The time
differs for each zip file.

The extracted files use a naming convention that matches the name of the data store, with underscores instead
of periods.

For example, if the data store name is CrmAnalyticsAM.OpportunityAM.Opportunity, the file name is
'file_crmanalyticsam_opportunityam_opportunity-batch2110193550-20160929_094418.zip'.

• To support parsing of the comma-separated value files, column values are wrapped in double quotes. The
double quote value in the column is escaped using two consecutive double quote values. Because of this, a
custom delimiter isn’t required.

• The decimal floating point numbers will have rounding errors due to representational limitations of binary
floating point formats in BICC. For example, a decimal number such as 1.365 may be represented as
1.364999999999999 when converting to DOUBLE type. \

CAUTION:  To ensure column names are sorted and appear in the ascending (deterministic) order in the extracted
files, you must select columns in the BI Cloud Connector Console. If you don't select columns then BI Cloud Connector
Console determines the columns available at run time and includes them in the extract files. Adding or removing a
column in the BI Cloud Connector Console changes the order of columns in the extract files.

Manifest File Formats and Content
The first line of a manifest file describes the source version. File name format depends on the configure storage area
and are detailed in a manifest file.

In UCM MANIFEST.MF files, the body of the file contains information about each of the uploaded files in the format
vo_name;ucm_document_id;md5_check_sum_value. For example, in the following sample line, from a UCM manifest file, 9526
is the UCM document ID of the uploaded file, ;b2af2bf486366e2c2cb7598849f0df2e is the check sum value.

crmanalyticsam_partiesanalyticsam_customer;9526;b2af2bf486366e2c2cb7598849f0df2e

In Cloud Storage Service MANIFEST-[TIMESTAMP].MF files, the body of the file contains information about each
of the uploaded files in the format  extract_uploaded_filename;md5_check_sum_value. For example, in the following
sample line, from a Storage Service manifest file, file_fscmtopmodelam_analyticsserviceam_currenciestlpvo-
batch1209716923-20150615_105514.zip is the uploaded file name, and ;b2af2bf486366e2c2cb7598849f0df2e is the
check sum value.

file_fscmtopmodelam_analyticsserviceam_currenciestlpvo-

batch1209716923-20150615_105514.zip;fa981be0caf70a9a52df3aceb9998cc9

Global Data Extract Manifest

• UCM will have MANIFEST.MF.

• Cloud Storage Service and OCI Object Storage manifest files have a file name format as MANIFEST-
<Timestamp>.MF.

• EXTRACT_STATUS_DATA_SCHEDULE_<SCHEDULE ID>_REQUEST_<REQUEST_ID>.JSON is common for all
data extracts.
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• EXTRACT_STATUS_PRIMARY_KEYS_SCHEDULE_<SCHEDULE ID>_REQUEST_<REQUEST_ID>.JSON is common
for all key extracts.

Jobs Manifest

Job specific extracts have the following Manifest file format:

• Data Extract

MANIFEST_DATA_<JOB_ID>-SCHEDULE_<SCHEDULE ID>_REQUEST_<ESS_REQUEST_ID>.MF

EXTRACT_STATUS_DATA_<JOB_ID>-SCHEDULE_<SCHEDULE ID>_REQUEST_<ESS_REQUEST_ID>.JSON

• Keys Extract

MANIFEST_PRIMARY_KEYS_<JOB_ID>-SCHEDULE_<SCHEDULE ID>_REQUEST_<ESS_REQUEST_ID>.MF

EXTRACT_STATUS_PRIMARY_KEYS_<JOB_ID>-SCHEDULE_<SCHEDULE
ID>_REQUEST_<ESS_REQUEST_ID>.JSON

Download and Process Content from UCM
To download extracted content from UCM, search for DOCTITLE MANIFEST.MF and sort by DOCDATE in DESC
order. This provides all of the manifest UCM files in order by docid. Download each MANIFEST file using docid.
Parse the lines in the manifest file to download data files using their respective ucm_document_ids. You can use the
md5_check_sum_value to verify downloaded file content. After downloading the files, unzip them and process them
based on their file extension, for example by .csv, .mdcsv, or .pecsv.

Once the data files are processed, rename the corresponding MANIFEST.MF file in UCM by adding a timestamp prefix
in the format [TIMESTAMP]_MANIFEST.MF so that it’s not reused in the next download from UCM. Expire the manifest
file and all the processed files after 30 days so that UCM storage doesn’t run out of space.

Download and Process Content from Cloud Storage Service
To download extracted content from Cloud Storage Service, search for MANIFEST- and sort by filename. This provides all
of the manifest files in order by date. Download each manifest file and parse the lines in the manifest file to download
data files using their respective file names. You can use the md5_check_sum_value to verify downloaded file content.
After downloading the files, unzip them and process them based on their file extension, for example by .csv, .mdcsv,
or .pecsv.

Once the data files are processed, rename the corresponding manifest file in Storage Service by adding a timestamp
prefix in the format [TIMESTAMP]_MANIFEST so that it’s not reused in the next download. Expire the manifest file and
all the processed files after 30 days so that storage doesn’t run out of space.

Encrypt Extracts  
BI Cloud Connector supports signed and unsigned encryption using Pretty Good Privacy (PGP) for files uploaded to
Universal Content Management (UCM). Optionally, you can enable signed extract files and download a generated
signing key.

Before you start
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Before you set up encryption, generate a key pair using PGP and export the public key from the key pair to a location
from which it can be imported. Encryption is performed using an imported public key. You can use the private key from
the key pair to decrypt your extracts.

To set up encryption for a data store:

Here's what to do

1. Click the Configure External Storage button in the panel tab and select the Configure External Storage link to
open the Configure External Storage dialog box.

2. Select the UCM Connection Configuration tab.
3. In the Data Encryption section, select Data Encryption.
4. Click Choose File to import the certificate from the key pair you generated. In the File Upload dialog box, navigate to

your key file, select it, and click Open. Click Update... to update a key. Imported certificates are stored in the GnuPG
keyring on the server host.

5. Optionally, select Sign Extract File to generate a signing key for your extracts.
6. If you choose to sign the extract files, click the Download Signing Key button to save the signing key.

a. In the Opening biccc.gpg dialog box, select Save File and click Browse to select a location to save the
signing key.

b. Click Save.
7. In the Key list, select the Key Id, then click Actions > Set as default to set a default key.
8. To delete a key, select Actions > Delete.

Results:
Encrypted extracts uploaded to UCM are stored with a suffix of .gpg.

What to do next

Decrypt Extracts  
BI Cloud Connector encrypts files before upload to Universal Content Management using the imported certificate you
provide. Use your private key to decrypt uploaded files.

To decrypt and verify signed files, download the signing key and verify that the keys are imported into the keystore and
appear in the Key list in the Configure External Storage dialog box. Use the following command to decrypt both signed
and unsigned .gpg files:

gpg --decrypt <inbound_file_name> --output <output_file_name>
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5  Integrate

SOAP API  
Use Simple Object Access Protocol (SOAP) web services to integrate different applications within the enterprise or
expose business functions to Oracle Cloud partners and customers.

SOAP helps you submit various XML requests to extract desired data. You can run data extraction and schedule jobs
using SOAP web services.Access SOAP API
Access SOAP API

Before you schedule extracts, here’s how you can access SOAP API and submit SOAP requests.

1. WSDL Server URL : For all supported operations, use https://servername.fa.us2.oraclecloud.com/bi/ess/
esswebservice?wsdl

2. SOAP Requests: To submit SOAP requests, use https://servername.fa.us2.oraclecloud.com/bi/ess/
esswebservice

Global Extract with Given Data Stores

Let’s learn how to use the ESS web service to schedule a job for running the BI cloud extracts.

ESS web service is a SOAP web service that provides operations to submit requests and request status for the submitted
jobs. Here’s what you need to do to schedule an extract:

• Configure the data stores in BICC console.

• Create global extract for specified data stores.

SOAP Headers Procedure

Security • Add username token for authentication with username and password.

• Add timestamp token with ‘created’ and ‘expires’ for the message time validation.

 

SOAP Body Provide details for the following attributes in the SOAP Body.

• Job Name: BICloudConnectorJobDefinition

• Package: oracle.apps.ess.biccc

• Type: JOB_DEFINITION

• Start Time: Provide start time in sch:requestedStartTime. If left null, the extract process will start
immediately.

• sch:application: oracle.biacm (hosting application)
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SOAP Headers Procedure

• Request Parameters

a. SYS_className:oracle.esshost.impl.CloudAdaptorJobImpl (Classname in the hosting app running
the job)

b. EXTRACT_TYPE: Job Type of the extract. Valid values are VO_EXTRACT (Cloud Data Extract)/
PRIMARY_KEY_EXTRACT (Deleted Records Extract)/VO_AND_PK_EXTRACT (Cloud Data and
Deleted Records extract)

c. Sys_application:BI Cloud Adaptor
d. DATA_STORE_LIST: Comma separated list of data stores for which the extract will be run. If you

don’t provide this list, the extracts will be run for the global data store list enabled in BICCC.

• Optional Preferences: You can specify the following optional preferences. You can specify data
type as STRING for all the parameters.

a. STARTED_NOTIFICATION - Send notification email when the extract begins? (true/false)
b. SUCCESS_NOTIFICATION - Send notification email when the extract succeeds? (true/false)
c. FAILURE_NOTIFICATION - Send notification email when the extract fails? (true/false)
d. MAIL_TO_ADDRESSES – Provide comma separated list of email addresses to send the

notifications emails.
e. FILE_EXPIRY_DAYS - Number of days after which the uploaded files will be expired.
f. FILE_SPLIT_SIZE - Split size (GB) for the extract files.

g. EXTRACT_COMPRESS_TYPE - Compression type for the files (zip/gzip)

 

Sample Request  (submitRequest)

<soapenv:Envelope
 xmlns:sch="http://xmlns.oracle.com/scheduler"
 xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"
 xmlns:typ="http://xmlns.oracle.com/scheduler/types">
 <soapenv:Header>
 <wsse:Security soapenv:mustUnderstand="1"
 xmlns:wsse="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-wssecurity-secext-1.0.xsd"
 xmlns:wsu="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-wssecurity-utility-1.0.xsd">
 <wsu:Timestamp wsu:Id="TS-A2DF758C7B92C0123015204688873404">
 <wsu:Created>2018-03-08T00:28:07.339Z</wsu:Created>
 <wsu:Expires>2018-03-08T00:30:07.339Z</wsu:Expires>
 </wsu:Timestamp>
 <wsse:UsernameToken wsu:Id="UsernameToken-A2DF758C7B92C0123015204688787403">
 <wsse:Username>xxxxxxx</wsse:Username>
 <wsse:Password Type="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-username-token-
profile-1.0#PasswordText">xxxxxxx</wsse:Password>
 <wsse:Nonce EncodingType="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-soap-message-
security-1.0#Base64Binary">yPFbN92Ojg6qYmGZHuKZSQ==</wsse:Nonce>
 <wsu:Created>2018-03-08T00:27:58.740Z</wsu:Created>
 </wsse:UsernameToken>
 </wsse:Security>
 </soapenv:Header>
 <soapenv:Body>
 <sch:submitRequest>
 <sch:description>Test ESS Web Service</sch:description>
 <sch:jobDefinitionId>
 <!--Optional:-->
 <typ:name>BICloudConnectorJobDefinition</typ:name>
 <!--Optional:-->
 <typ:packageName>oracle.apps.ess.biccc</typ:packageName>
 <!--Optional:-->
 <typ:type>JOB_DEFINITION</typ:type>
 </sch:jobDefinitionId>
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 <sch:application>oracle.biacm</sch:application>
 <sch:requestedStartTime/>
 <sch:requestParameters>
 <!--0 to 1000 repetitions:-->
 <typ:parameter>
 <!--Optional:-->
 <typ:dataType>STRING</typ:dataType>
 <!--Optional:-->
 <typ:name>SYS_className</typ:name>
 <!--Optional:-->
 <typ:scope/>
 <!--Optional:-->
 <typ:value>oracle.esshost.impl.CloudAdaptorJobImpl</typ:value>
 </typ:parameter>
 <typ:parameter>
 <!--Optional:-->
 <typ:dataType>STRING</typ:dataType>
 <!--Optional:-->
 <typ:name>SYS_application</typ:name>
 <!--Optional:-->
 <typ:scope/>
 <!--Optional:-->
 <typ:value>BI Cloud Adaptor</typ:value>
 </typ:parameter>
 <typ:parameter>
 <!--Optional:-->
 <typ:dataType>STRING</typ:dataType>
 <!--Optional:-->
 <typ:name>EXTRACT_JOB_TYPE</typ:name>
 <!--Optional:-->
 <typ:scope/>
 <!--Optional:-->
 <typ:value>VO_EXTRACT</typ:value>
 </typ:parameter>
 <typ:parameter>
 <!--Optional:-->
 <typ:dataType>STRING</typ:dataType>
 <!--Optional:-->
 <typ:name>DATA_STORE_LIST</typ:name>
 <!--Optional:-->
 <typ:scope/>
 <!--Optional:-->
 <typ:value>CrmAnalyticsAM.PartiesAnalyticsAM.Location,CrmAnalyticsAM.PartiesAnalyticsAM.Organization,CrmAnalyticsAM.PartiesAnalyticsAM.PartyContactEmail</
typ:value>
 </typ:parameter>
 <typ:parameter>
 <!--Optional:-->
 <typ:dataType>STRING</typ:dataType>
 <!--Optional:-->
 <typ:name>EXTERNAL_STORAGE_LIST</typ:name>
 <!--Optional:-->
 <typ:scope/>
 <!--Optional:-->
 <typ:value>storage1</typ:value>
 </typ:parameter>
 </sch:requestParameters>
 </sch:submitRequest>
 </soapenv:Body>
</soapenv:Envelope>

Sample Response  (submitRequest) - Returns an ESS Job Id

<env:Envelope
 xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
 xmlns:wsa="http://www.w3.org/2005/08/addressing">
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 <env:Header>
 <wsa:Action>submitRequest</wsa:Action>
 <wsa:MessageID>urn:uuid:b612af67-4769-4eac-9abc-f2bd8b0ed1bf</wsa:MessageID>
 <wsa:RelatesTo>uuid:073d2715-5e6c-4968-a4f5-e1d88da1897b</wsa:RelatesTo>
 </env:Header>
 <env:Body>
 <ns0:submitRequestResponse
 xmlns:ns0="http://xmlns.oracle.com/scheduler">
 <requestId
 xmlns:ns2="http://xmlns.oracle.com/scheduler/types">49318
 </requestId>
 </ns0:submitRequestResponse>
 </env:Body>
</env:Envelope>

SOAP Request to Get the Job State (getRequestState)

Pass the Request ID from the submitted job.

Sample Request

<soapenv:Envelope
 xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"
 xmlns:sch="http://xmlns.oracle.com/scheduler">
 <soapenv:Header>
 <wsse:Security
 xmlns:wsse="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-wssecurity-secext-1.0.xsd"
 xmlns:wsu="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-wssecurity-utility-1.0.xsd"
 soapenv:mustUnderstand="1">
 <wsse:UsernameToken wsu:Id="UsernameToken-096D9A2FA5EEE63DC514744911304045">
 <wsse:Username>faadmin</wsse:Username>
 <wsse:Password Type="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-username-token-
profile-1.0#PasswordText">xxxxxx</wsse:Password>
 <wsse:Nonce EncodingType="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-soap-message-
security-1.0#Base64Binary">96M4RBdl+afFA6MUufbbAQ==</wsse:Nonce>
 <wsu:Created>2016-09-21T20:52:10.404Z</wsu:Created>
 </wsse:UsernameToken>
 </wsse:Security>
 </soapenv:Header>
 <soapenv:Body>
 <sch:getRequestState>
 <sch:requestId>49318</sch:requestId>
 </sch:getRequestState>
 </soapenv:Body>
</soapenv:Envelope>

Sample Response - Returns the Job State

<env:Envelope
 xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
 xmlns:wsa="http://www.w3.org/2005/08/addressing">
 <env:Header>
 <wsa:Action>getRequestState</wsa:Action>
 <wsa:MessageID>urn:uuid:b44f932b-2b21-41c0-b748-1ec5007fe05f</wsa:MessageID>
 <wsa:RelatesTo>uuid:374006ab-6fc5-4073-950a-dd6018d1308c</wsa:RelatesTo>
 </env:Header>
 <env:Body>
 <ns0:getRequestStateResponse
 xmlns:ns0="http://xmlns.oracle.com/scheduler">
 <state
 xmlns:ns2="http://xmlns.oracle.com/scheduler/types">RUNNING
 </state>
 </ns0:getRequestStateResponse>
 </env:Body>
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</env:Envelope>

SOAP Request to Get the Request Detail (getRequestDetail)

Pass the Request ID from the submitted job.

Sample Request

<soapenv:Envelope
 xmlns:sch="http://xmlns.oracle.com/scheduler"
 xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/">
 <soapenv:Header>
 <wsse:Security soapenv:mustUnderstand="1"
 xmlns:wsse="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-wssecurity-secext-1.0.xsd"
 xmlns:wsu="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-wssecurity-utility-1.0.xsd">
 <wsse:UsernameToken wsu:Id="UsernameToken-096D9A2FA5EEE63DC514744918990386">
 <wsse:Username>faadmin</wsse:Username>
 <wsse:Password Type="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-username-token-
profile-1.0#PasswordText">xxxxxx</wsse:Password>
 <wsse:Nonce EncodingType="http://docs.oasis-open.org/wss/2004/01/oasis-200401-wss-soap-message-
security-1.0#Base64Binary">5WwwW1fii5/6DKpgBafreQ==</wsse:Nonce>
 <wsu:Created>2016-09-21T21:04:59.038Z</wsu:Created>
 </wsse:UsernameToken>
 </wsse:Security>
 </soapenv:Header>
 <soapenv:Body>
 <sch:getRequestDetail>
 <sch:requestId>49318</sch:requestId>
 </sch:getRequestDetail>
 </soapenv:Body>
</soapenv:Envelope> 

Sample Response - Returns the Job Definition and Status

<env:Envelope
 xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
 xmlns:wsa="http://www.w3.org/2005/08/addressing">
 <env:Header>
 <wsa:Action>getRequestDetail</wsa:Action>
 <wsa:MessageID>urn:uuid:bc779307-1819-4667-8cec-b246405011a1</wsa:MessageID>
 <wsa:RelatesTo>uuid:055a802b-ab9e-46f5-9a87-b54bcde19a4a</wsa:RelatesTo>
 </env:Header>
 <env:Body>
 <ns0:getRequestDetailResponse
 xmlns:ns0="http://xmlns.oracle.com/scheduler">
 <requestDetail
 xmlns:ns2="http://xmlns.oracle.com/scheduler/types">
 <ns2:requestId>49318</ns2:requestId>
 <ns2:description>Test_ESS</ns2:description>
 <ns2:jobDefinitionId>
 <ns2:type>JOB_DEFINITION</ns2:type>
 <ns2:packageName>/oracle.apps.ess.biccc</ns2:packageName>
 <ns2:name>BICloudConnectorJobDefinition</ns2:name>
 </ns2:jobDefinitionId>
 <ns2:dispatcherNode>bi_server1</ns2:dispatcherNode>
 <ns2:processorNode>bi_server1</ns2:processorNode>
 <ns2:workAssignmentId>
 <ns2:type>WORK_ASSIGNMENT</ns2:type>
 <ns2:packageName>/oracle/as/ess/essapp/internal</ns2:packageName>
 <ns2:name>defaultWA</ns2:name>
 </ns2:workAssignmentId>
 <ns2:workshiftId>
 <ns2:type>WORKSHIFT</ns2:type>
 <ns2:packageName>/oracle/as/ess/essapp/internal</ns2:packageName>
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 <ns2:name>defaultWS</ns2:name>
 </ns2:workshiftId>
 <ns2:isCancellable>true</ns2:isCancellable>
 <ns2:isHoldable>false</ns2:isHoldable>
 <ns2:retried>0</ns2:retried>
 <ns2:executionAttempt>1</ns2:executionAttempt>
 <ns2:submitter>FAAdmin</ns2:submitter>
 <ns2:runAsUser>FAAdmin</ns2:runAsUser>
 <ns2:submissionTime>2016-09-21T21:00:38.563Z</ns2:submissionTime>
 <ns2:requestedStartTime>2016-09-21T21:00:38.563Z</ns2:requestedStartTime>
 <ns2:scheduledTime>2016-09-21T21:00:38.563Z</ns2:scheduledTime>
 <ns2:actualStartTime>2016-09-21T21:00:53.362Z</ns2:actualStartTime>
 <ns2:state>RUNNING</ns2:state>
 <ns2:priority>4</ns2:priority>
 <ns2:cause>Request in non-terminal state</ns2:cause>
 <ns2:parentRequestId>0</ns2:parentRequestId>
 <ns2:stepId>0</ns2:stepId>
 <ns2:requestType>SINGLETON</ns2:requestType>
 <ns2:requestParameters>
 <ns2:parameter>
 <ns2:dataType>INTEGER</ns2:dataType>
 <ns2:name>SYS_priority</ns2:name>
 <ns2:scope/>
 <ns2:value>4</ns2:value>
 </ns2:parameter>
 <ns2:parameter>
 <ns2:dataType>STRING</ns2:dataType>
 <ns2:name>EXTRACT_JOB_TYPE</ns2:name>
 <ns2:scope/>
 <ns2:value>VO_EXTRACT</ns2:value>
 </ns2:parameter>
 <ns2:parameter>
 <ns2:dataType>STRING</ns2:dataType>
 <ns2:name>SYS_userName</ns2:name>
 <ns2:scope/>
 <ns2:value>FAAdmin</ns2:value>
 </ns2:parameter>
 <ns2:parameter>
 <ns2:dataType>INTEGER</ns2:dataType>
 <ns2:name>SYS_retries</ns2:name>
 <ns2:scope/>
 <ns2:value>0</ns2:value>
 </ns2:parameter>
 <ns2:parameter>
 <ns2:dataType>STRING</ns2:dataType>
 <ns2:name>SYS_className</ns2:name>
 <ns2:scope/>
 <ns2:value>oracle.esshost.impl.CloudAdaptorJobImpl</ns2:value>
 </ns2:parameter>
 <ns2:parameter>
 <ns2:dataType>LONG</ns2:dataType>
 <ns2:name>SYS_request_timeout</ns2:name>
 <ns2:scope/>
 <ns2:value>0</ns2:value>
 </ns2:parameter>
 <ns2:parameter>
 <ns2:dataType>STRING</ns2:dataType>
 <ns2:name>SYS_groupName</ns2:name>
 <ns2:scope/>
 <ns2:value>ESS_DefaultIsolationGroup</ns2:value>
 </ns2:parameter>
 <ns2:parameter>
 <ns2:dataType>STRING</ns2:dataType>
 <ns2:name>SYS_submittingApplication</ns2:name>
 <ns2:scope/>
 <ns2:value>oracle.biacm</ns2:value>
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 </ns2:parameter>
 <ns2:parameter>
 <ns2:dataType>BOOLEAN</ns2:dataType>
 <ns2:name>SYS_EXT_userFileDirShared</ns2:name>
 <ns2:scope/>
 <ns2:value>false</ns2:value>
 </ns2:parameter>
 <ns2:parameter>
 <ns2:dataType>INTEGER</ns2:dataType>
 <ns2:name>SYS_requestExpiration</ns2:name>
 <ns2:scope/>
 <ns2:value>0</ns2:value>
 </ns2:parameter>
 <ns2:parameter>
 <ns2:dataType>STRING</ns2:dataType>
 <ns2:name>SYS_application</ns2:name>
 <ns2:scope/>
 <ns2:value>oracle.biacm</ns2:value>
 </ns2:parameter>
 <ns2:parameter>
 <ns2:dataType>STRING</ns2:dataType>
 <ns2:name>SYS_userFileDir</ns2:name>
 <ns2:scope/>
 <ns2:value>${ESS_ENV:jrfServerLogPath}/ess_request</ns2:value>
 </ns2:parameter>
 <ns2:parameter>
 <ns2:dataType>INTEGER</ns2:dataType>
 <ns2:name>SYS_reprocessDelay</ns2:name>
 <ns2:scope/>
 <ns2:value>5</ns2:value>
 </ns2:parameter>
 <ns2:parameter>
 <ns2:dataType>BOOLEAN</ns2:dataType>
 <ns2:name>SYS_executePast</ns2:name>
 <ns2:scope/>
 <ns2:value>true</ns2:value>
 </ns2:parameter>
 </ns2:requestParameters>
 <ns2:ecid>5aa4a1152ec38837:-422f90c2:157393de3be:-8000-000000000006e4bc</ns2:ecid>
 <ns2:processPhase>ExecuteFinalize</ns2:processPhase>
 </requestDetail>
 </ns0:getRequestDetailResponse>
 </env:Body>
</env:Envelope>

Schedule a Job

Let’s look at how to submit schedules for existing jobs using ESS request. You can get the job Id from the Manage Jobs
page.

SOAP Headers Procedure

Security • Click the Auth tab to provide authentication information for accessing the web service.

• Enter the username and password.

SOAP Body Provide details for the following attributes in the SOAP Body.

• Job Name: BICloudConnectorJobDefinition

• Package: oracle.apps.ess.biccc

• Type: JOB_DEFINITION
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SOAP Headers Procedure

• Start Time: Provide start time in sch:requestedStartTime. If left null, the extract process will start
immediately.

• sch:application: oracle.biacm (hosting application)

• Request Parameters.

a. SYS_className:oracle.esshost.impl.CloudAdaptorJobImpl (Classname in the hosting app running
the job)

b. SYS_requestCategory: JobSchedule (Identifies as a schedule for a Job definition)
c. EXTRACT_JOB_TYPE: Job Type of the extract. Valid values are VO_EXTRACT (Application

Data Extract)/PRIMARY_KEY_EXTRACT Active Primary Key Extract)/VO_AND_PK_EXTRACT
(Application Data and Active Primary Key extract)

d. EXTERNAL_STORAGE_LIST: External Storages to upload the files to. You can obtain the external
storage names from the BICCC UI ->Configure External Storage. You can upload files to a
maximum of two external storages.

e. JOB_ID: Job Id for which the schedule is being created.
f. Optional Preferences: You can specify the following optional preferences. You can specify data

type as STRING for all the parameters.
g. STARTED_NOTIFICATION - Send notification email when the extract begins? (true/false).
h. SUCCESS_NOTIFICATION – Send notification email when the extract succeeds? (true/false).
i. FAILURE_NOTIFICATION - Should notification email be sent when the extract failed? (true/false).
j. MAIL_TO_ADDRESSES - Comma seperated list of email addresses to whom the notification

should be sent.
k. FILE_EXPIRY_DAYS - Number of days after which the uploaded files will be expired.
l. FILE_SPLIT_SIZE - Split size (GB) for the extract files.

m. EXTRACT_COMPRESS_TYPE - Compression type for the files (zip/gzip).
n. EXTERNAL_STORAGE_FILE_NAME_PREFIX - Uploaded file name prefix support for OCI Object

Storage.
o. Sys_application:BI Cloud Adaptor.

Sample Request

 <sch:submitRequest>
 <sch:description>job schedule test 1</sch:description>
 <sch:jobDefinitionId>
 <!--Optional:-->
 <typ:name>BICloudConnectorJobDefinition</typ:name>
 <!--Optional:-->
 <typ:packageName>oracle.apps.ess.biccc</typ:packageName>
 <!--Optional:-->
 <typ:type>JOB_DEFINITION</typ:type>
 </sch:jobDefinitionId>
 <sch:application>oracle.biacm</sch:application>
 <sch:requestedStartTime/>
 <sch:requestParameters>
 <!--0 to 1000 repetitions:-->
 <typ:parameter>
 <!--Optional:-->
 <typ:dataType>STRING</typ:dataType>
 <!--Optional:-->
 <typ:name>SYS_className</typ:name>
 <!--Optional:-->
 <typ:scope/>
 <!--Optional:-->
 <typ:value>oracle.esshost.impl.CloudAdaptorJobImpl</typ:value>
 </typ:parameter>
 <typ:parameter>
 <!--Optional:-->
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 <typ:dataType>STRING</typ:dataType>
 <!--Optional:-->
 <typ:name>SYS_requestCategory</typ:name>
 <!--Optional:-->
 <typ:scope/>
 <!--Optional:-->
 <typ:value>JobSchedule</typ:value>
 </typ:parameter>
 <typ:parameter>
 <!--Optional:-->
 <typ:dataType>STRING</typ:dataType>
 <!--Optional:-->
 <typ:name>SYS_application</typ:name>
 <!--Optional:-->
 <typ:scope/>
 <!--Optional:-->
 <typ:value>BI Cloud Adaptor</typ:value>
 </typ:parameter>
 <typ:parameter>
 <!--Optional:-->
 <typ:dataType>STRING</typ:dataType>
 <!--Optional:-->
 <typ:name>EXTRACT_JOB_TYPE</typ:name>
 <!--Optional:-->
 <typ:scope/>
 <!--Optional:-->
 <typ:value>VO_EXTRACT</typ:value>
 </typ:parameter>
 <typ:parameter>
 <!--Optional:-->
 <typ:dataType>LONG</typ:dataType>
 <!--Optional:-->
 <typ:name>JOB_ID</typ:name>
 <!--Optional:-->
 <typ:scope/>
 <!--Optional:-->
 <typ:value>142</typ:value>
 </typ:parameter>
 <typ:parameter>
 <!--Optional:-->
 <typ:dataType>STRING</typ:dataType>
 <!--Optional:-->
 <typ:name>EXTERNAL_STORAGE_LIST</typ:name>
 <!--Optional:-->
 <typ:scope/>
 <!--Optional:-->
 <typ:value>UCM</typ:value>
 </typ:parameter>
 </sch:requestParameters>
 </sch:submitRequest>

Troubleshooting

If the ESS web service fails and displays the error message "Security Token Is Not Valid", verify that the timestamp in the
SOAP header is valid and hasn’t expired. If expired, generate a new timestamp and resubmit the request.

<wsu:Timestamp wsu:Id="TS-A2DF758C7B92C0123015204688873404">
 <wsu:Created>2018-03-08T00:28:07.339Z</wsu:Created>
 <wsu:Expires>2018-03-08T00:30:07.339Z</wsu:Expires>
</wsu:Timestamp>
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Manage Meta Data REST API  
You can use Oracle REST APIs to view data store extract metadata.

Access REST API
To make a REST HTTP request, you need to gather a few bits of information:

• REST Server URL: Typically, the URL of your Oracle Cloud service. For example, https://
servername.fa.us2.oraclecloud.com:<host:port>/biacm/rest

• User name and password: An Oracle Cloud service user with permissions to access the resources you're using.

You can find the REST Server URL, user name, and password in the welcome email sent to your Oracle Cloud service
administrator.

Get DataStoreMeta

Get a DataStore metadata by passing "dataStoreId" as PathParam. QueryParam "locale" is optional.

Example URL

Here’s an example of the resource URL:

GET

/meta/datastores/CrmAnalyticsAM.PartiesAnalyticsAM.Person
/meta/datastores/CrmAnalyticsAM.PartiesAnalyticsAM.Person?locale=ko

Example Response

Here’s an example of the response body in JSON format:

{
 "dataStoreId": "CrmAnalyticsAM.PartiesAnalyticsAM.Person",
 "dataStoreName": "CrmAnalyticsAM.PartiesAnalyticsAM.Person",
 "filters": null,
 "isEffectiveDateDisabled": false,
 "isFlexDataStore": false,
 "isSilentError": false,
 "columns": [{
 "name": "CreatedBy",
 "label": "Created By",
 "dataType": "VARCHAR",
 "size": "64",
 "precision": "64",
 "scale": "-127",
 "isPrimaryKey": false,
 "isPopulate": true,
 "isLastUpdateDate": false,
 "isNaturalKey": false
 }, {
 "name": "CreationDate",
 "label": "Creation Date",
 "dataType": "TIMESTAMP",
 "size": "0",
 "precision": "0",
 "scale": "-127",
 "isPrimaryKey": false,
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 "isPopulate": true,
 "isLastUpdateDate": false,
 "isNaturalKey": false
 }, {
 "name": "LastUpdateDate",
 "label": "Last Updated Date",
 "dataType": "TIMESTAMP",
 "size": "0",
 "precision": "0",
 "scale": "-127",
 "isPrimaryKey": false,
 "isPopulate": true,
 "isLastUpdateDate": true,
 "isNaturalKey": false
 }, {
 "name": "LastUpdatedBy",
 "label": "Last Updated By",
 "dataType": "VARCHAR",
 "size": "64",
 "precision": "64",
 "scale": "-127",
 "isPrimaryKey": false,
 "isPopulate": true,
 "isLastUpdateDate": false,
 "isNaturalKey": false
 }, {
 "name": "PartyId",
 "label": "PartyId",
 "dataType": "NUMERIC",
 "size": "8",
 "precision": "18",
 "scale": "0",
 "isPrimaryKey": false,
 "isPopulate": true,
 "isLastUpdateDate": false,
 "isNaturalKey": false
 }, {
 "name": "PersonProfileId",
 "label": "PersonProfileId",
 "dataType": "NUMERIC",
 "size": "8",
 "precision": "18",
 "scale": "0",
 "isPrimaryKey": true,
 "isPopulate": true,
 "isLastUpdateDate": false,
 "isNaturalKey": false
 }, 

VO Metadata Expected Behavior

This section provides additional details about Metadata API attributes for SDM VO and Non SDM VOs.

The following table lists the difference in the VO attributes for SDM VO and Non SDM VOs.

1 VO Attributes for SDM VO and Non SDM VOs

VO Attribute SDM VO (Attribute Fetched) Non SDM VO (Attribute Fetched)

dataStoreId Yes Yes
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VO Attribute SDM VO (Attribute Fetched) Non SDM VO (Attribute Fetched)

dataStoreName Yes Yes

filters Yes No

isEffectiveDateDisabled Yes No

isFlexDataStore Yes No

isSilentError Yes No

The following table lists the difference in the Column attributes for SDM VO and Non SDM VOs.

2 Column Attributes for SDM VO and Non SDM VOs

VO Attribute SDM VO (Attribute Fetched) Non SDM VO (Attribute Fetched)

name Yes Yes

label Yes Yes

dataType Yes Yes

size Yes Yes

precision Yes Yes

scale Yes Yes

isPrimaryKey Yes No

isPopulate Yes No

isLastUpdateDate Yes No

isNaturalKey Yes No

isEffectiveStartDate Yes No

isCreationDate Yes No

colConversion Yes No

Get DataStoreMeta with User Customization

Get a DataStore metadata by passing "dataStoreId" as PathParam. QueryParam "locale" is optional.

Example URL

Here’s an example of the resource URL:

GET
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/meta/datastores/CrmAnalyticsAM.PartiesAnalyticsAM.Person?includeCustomization=true

/meta/datastores/CrmAnalyticsAM.PartiesAnalyticsAM.Person?includeCustomization=true&locale=ko

Example Response

Here’s an example of the response body in JSON format:

{
 "dataStoreId": "CrmAnalyticsAM.PartiesAnalyticsAM.Person",
 "dataStoreName": "CrmAnalyticsAM.PartiesAnalyticsAM.Person",
 "filters": null,
 "isEffectiveDateDisabled": false,
 "isFlexDataStore": false,
 "isSilentError": false,
 "columns": [{
 "name": "CreatedBy",
 "label": "Created By",
 "dataType": "VARCHAR",
 "size": "64",
 "precision": "64",
 "scale": "-127",
 "isPrimaryKey": false,
 "isPopulate": true,
 "isLastUpdateDate": false,
 "isNaturalKey": false
 }, {
 "name": "CreationDate",
 "label": "Creation Date",
 "dataType": "TIMESTAMP",
 "size": "0",
 "precision": "0",
 "scale": "-127",
 "isPrimaryKey": false,
 "isPopulate": true,
 "isLastUpdateDate": false,
 "isNaturalKey": false
 }, {
 "name": "LastUpdateDate",
 "label": "Last Updated Date",
 "dataType": "TIMESTAMP",
 "size": "0",
 "precision": "0",
 "scale": "-127",
 "isPrimaryKey": false,
 "isPopulate": true,
 "isLastUpdateDate": true,
 "isNaturalKey": false
 }, {
 "name": "LastUpdatedBy",
 "label": "Last Updated By",
 "dataType": "VARCHAR",
 "size": "64",
 "precision": "64",
 "scale": "-127",
 "isPrimaryKey": false,
 "isPopulate": true,
 "isLastUpdateDate": false,
 "isNaturalKey": false
 }, {
 "name": "PartyId",
 "label": "PartyId",
 "dataType": "NUMERIC",
 "size": "8",
 "precision": "18",
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 "scale": "0",
 "isPrimaryKey": false,
 "isPopulate": true,
 "isLastUpdateDate": false,
 "isNaturalKey": false
 }, {
 "name": "PersonProfileId",
 "label": "PersonProfileId",
 "dataType": "NUMERIC",
 "size": "8",
 "precision": "18",
 "scale": "0",
 "isPrimaryKey": true,
 "isPopulate": true,
 "isLastUpdateDate": false,
 "isNaturalKey": false
 }, 

Create or Update Data Store

Use this method to create or update a data store. For example, to add filters to a data store. Get a DataStore metadata
by passing 'dataStoreId' as PathParam. Add the required filter to the 'filters' attribute and a rootkey dsmeta to the JSON
file.

Example URL

Here’s an example of the resource URL:

PUT

/meta/datastores/

Sample Request

Here's an example of sample request body in JSON format.

 {"offerings": ["HR_AN_OFRNG"],
 "dsMeta":{
 "dataStoreId": "CrmAnalyticsAM.GeographiesAnalyticsAM.ZoneHelper",
 "dataStoreName": "CrmAnalyticsAM.GeographiesAnalyticsAM.ZoneHelper",
 "filters": null,
 "isEffectiveDateDisabled": false,
 "isFlexDataStore": false,
 "isSilentError": false,
 "columns": [
 {
 "name": "MasChildId",
 "label": "MasChildId",
 "dataType": "NUMERIC",
 "size": "8",
 "precision": "0",
 "scale": "-127",
 "isPrimaryKey": false,
 "isPopulate": true,
 "isLastUpdateDate": false,
 "isNaturalKey": false,
 "isEffectiveStartDate": false,
 "isCreationDate": false,
 "colConversion": null
 },
 {
 "name": "MasHierarchyNodeId",
 "label": "MasHierarchyNodeId",
 "dataType": "NUMERIC",
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 "size": "8",
 "precision": "18",
 "scale": "0",
 "isPrimaryKey": true,
 "isPopulate": true,
 "isLastUpdateDate": false,
 "isNaturalKey": false,
 "isEffectiveStartDate": false,
 "isCreationDate": false,
 "colConversion": null
 },
 {
 "name": "MasLastUpdateDate",
 "label": "MasLastUpdateDate",
 "dataType": "TIMESTAMP",
 "size": "0",
 "precision": "0",
 "scale": "-127",
 "isPrimaryKey": false,
 "isPopulate": true,
 "isLastUpdateDate": true,
 "isNaturalKey": false,
 "isEffectiveStartDate": false,
 "isCreationDate": false,
 "colConversion": null
 },
 {
 "name": "MasLevelNumber",
 "label": "MasLevelNumber",
 "dataType": "NUMERIC",
 "size": "8",
 "precision": "0",
 "scale": "-127",
 "isPrimaryKey": false,
 "isPopulate": true,
 "isLastUpdateDate": false,
 "isNaturalKey": false,
 "isEffectiveStartDate": false,
 "isCreationDate": false,
 "colConversion": null
 }]
 }}

Get Job Definition

Get a Job definition by passing "jobId" as PathParam. For example - /meta/jobs/1

Example URL

Here’s an example of the resource URL:

GET

/meta/jobs/{jobId}

Sample Response

 {
 "dataStores": [
 {
 "dataStoreMeta": {
 "columns": [
 {
 "name": "CreatedBy",
 "isPrimaryKey": false,
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 "isPopulate": false,
 "isLastUpdateDate": false,
 "isNaturalKey": false,
 "isEffectiveStartDate": false,
 "isCreationDate": false,
 "colConversion": null
 },
 {
 "name": "CreationDate",
 "isPrimaryKey": false,
 "isPopulate": false,
 "isLastUpdateDate": false,
 "isNaturalKey": false,
 "isEffectiveStartDate": false,
 "isCreationDate": true,
 "colConversion": null
 },
 {
 "name": "EnabledFlag",
 "isPrimaryKey": false,
 "isPopulate": false,
 "isLastUpdateDate": false,
 "isNaturalKey": false,
 "isEffectiveStartDate": false, 
 "isCreationDate": false,
 "colConversion": null
 },
 {
 "name": "LastUpdateDate",
 "isPrimaryKey": false,
 "isPopulate": false,
 "isLastUpdateDate": false,
 "isNaturalKey": false,
 "isEffectiveStartDate": false,
 "isCreationDate": false,
 "colConversion": null
 },
 {
 "name": "LastUpdatedBy",
 "isPrimaryKey": false,
 "isPopulate": false,
 "isLastUpdateDate": false,
 "isNaturalKey": false,
 "isEffectiveStartDate": false,
 "isCreationDate": false,
 "colConversion": null
 },

Create or Update Job

Use this method to create or update a job. For example - /meta/jobs/

Example URL

Here’s an example of the resource URL:

PUT

/meta/jobs/

Sample Request

 {
 "dataStores": [
 {
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 "dataStoreMeta": {
 "columns": [
 {
 "name": "CreatedBy",
 "isPrimaryKey": false,
 "isPopulate": false,
 "isLastUpdateDate": false,
 "isNaturalKey": false,
 "isEffectiveStartDate": false,
 "isCreationDate": false,
 "colConversion": null
 },
 {
 "name": "CreationDate",
 "isPrimaryKey": false,
 "isPopulate": false,
 "isLastUpdateDate": false,
 "isNaturalKey": false,
 "isEffectiveStartDate": false,
 "isCreationDate": true,
 "colConversion": null
 },
 {
 "name": "EnabledFlag",
 "isPrimaryKey": false,
 "isPopulate": false,
 "isLastUpdateDate": false,
 "isNaturalKey": false,
 "isEffectiveStartDate": false,
 "isCreationDate": false,
 "colConversion": null
 },
 {
 "name": "LastUpdateDate",
 "isPrimaryKey": false,
 "isPopulate": false,
 "isLastUpdateDate": false,
 "isNaturalKey": false,
 "isEffectiveStartDate": false,
 "isCreationDate": false,
 "colConversion": null
 },
 {
 "name": "LastUpdatedBy",
 "isPrimaryKey": false,
 "isPopulate": false,
 "isLastUpdateDate": false,
 "isNaturalKey": false,
 "isEffectiveStartDate": false,
 "isCreationDate": false,
 "colConversion": null
 ],
 "dataStoreKey": "FscmTopModelAM.FinGlJrnlEntriesAM.JournalHeaderPVO",
 "filters": "__DATASTORE__.JrnlHdrPeriodName = 'Nov-21' and
__DATASTORE__.JournalBatchPostingStatusCode = 'P'",
 "isEffectiveDateDisabled": false,
 "isFlexDataStore": false,
 "isSilentError": true,
 "initialExtractDate": null,
 "chunkType": null,
 "chunkDateSeqIncr": 0,
 "chunkDateSeqMin": 0,
 "chunkPkSeqIncr": 0,
 "useUnionForIncremental": false
 },
 "lastExtractDate": "2021-04-01T21:19:30.000",
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 "groupNumber": 0,
 "groupItemPriority": 0
 }
 ],
 "schedules": null,
 "name": "CFA_RFR_GL_FULL_CUSTOM_JOB",
 "description": "FULL Period Extract Job to sync FCR GL Transaction sync
tables from ERP"
}

Sample Response

 {
 "status": <SUCCESS/SUCCESS_WITH_WARNING>,
 "id": <JOB_ID>,
 "message": <Any warning message>
 }

52


	Creating a Business Intelligence Cloud Extract
	Get Help
	Get Started
	Overview of Business Intelligence Cloud Connector
	Provision Access
	Overview of Access Provisioning
	Provision a User with Access to BICC
	Provision a User with Access to BICC Content on UCM

	Roadmap for the Cloud Extracts
	Review Database Lineage Mappings and View Objects
	Sign In To BICC

	Implement
	Configure Where to Load Data
	Create and Manage an Offering
	Add a Datastore for an Offering
	Configure Extract Preferences
	Configure Flexfield Label Languages
	Configure Offerings to Extract
	Perform Advanced Extract Configuration

	Schedule Extracts and Jobs
	Specify When to Run Global Extract Jobs
	Create a New or Edit an Existing Data Extract Schedule
	Preview and Edit a Datastore for an Offering
	Add a Job
	Manage Job Data Stores
	Preview and Edit Job Data Stores
	Customize Job Data Stores
	Add a Job Schedule
	View Last Run Status for a Cloud Data Extract
	View Last Run Status for a Deleted Record Extract
	Reset Last Extract Date For All Enabled Data Stores

	Administer
	Manage Files in External Storage for Custom Warehouse Integration
	Encrypt Extracts
	Decrypt Extracts

	Integrate
	SOAP API
	Manage Meta Data REST API



